What is FrontPage?
FrontPage is a program that allows the user to create and maintain webs and web pages. A web is a collection of HTML, graphic, sound, and other files.

Section 1. Planning a web site
When planning your site, keep three considerations in mind: Content, Organization, and Functionality.

  Content- Ask yourself the following questions, “Who is my audience?”, “What is the purpose of the web?”, “What information is the web intended to provide?”

  Organization- Careful planning of your web’s layout will save you significant time in the long run. Each web should begin with a home page and every additional page should link back to your home page. Make it obvious to the user how to move from one level to another.

  Functionality- Create a map for hyperlinks to ensure that the web allows users as much freedom as possible. Develop a plan to update your web on a regular basis.

Spend some time looking at other sites on the web while planning your own. Make note of and study sites that appeal to you and seem easy to use. Keep in mind that unless you set up a password protected web site, all information that you post to your web site is public.

Section 2. Requesting a web site
You will all have a web site based on the files put into your M:/WWW folder.

Section 3. Web Site Basics

?? You must create their web sites in a software program designed to make HTML files (HTML= hypertext markup language.). The supported software for creating web pages at the KSG is FrontPage. Please contact your FSA to have FrontPage installed on your computer.

?? Some examples of software that you can use to make web sites are: Microsoft’s FrontPage, Netscape's Composer, or Macromedia's Dreamweaver. The advantage of FrontPage is that it allows you to manage your whole web site, and then edit your pages in a professional WYSIWIG editor. (WYSIWIG = what you see is what you get). Some of the other HTML editor software available is very limited (i.e. few features). For example, you cannot edit easily using Netscape Communicator. FrontPage happens to be made by Microsoft—and so it has many features that are similar to the features in Word, Excel, PowerPoint, etc.

Section 4. Create A New Web Page Using FrontPage

Step 1. Opening your FrontPage Web

?? Open FrontPage
?? Select File, Open Web
Type the **full** name of your web site in the folder name box. For example, in the case below we are opening the web site, http://www.ksg.harvard.edu/student1
Open the folder.
You will now be prompted for the username and password that you have chosen for your site. **Commit this information to memory, as you will need to enter it every time that you work on your site.**

![Enter Network Password](image)

You can now begin the fun job of designing your site!!

**Step 2. Exploring FrontPage 2000**

The most apparent change in the recent release of FrontPage is the integration of the two main components of FrontPage, the **Explorer and the Editor**. Instead of two different tools, one for page creation another for managing your site, there is now a single tool for handling both tasks.

Let's take a look at some of the features of the FrontPage interface: **Views** and the **Toolbar**.

Along the left side of the screen is the "Views" bar. These buttons provide different ways of looking at your FrontPage web –

- **The Page button** is the starting point for creating HTML documents in a web. This view allows the user to insert the text, graphics, and hyperlinks, etc that comprise a web page.
- **The Folders button** is similar to the Details view in Windows Explorer or My Computer: the directory structure is on the left and the detailed list from the selected directory is on the right. It displays the files on your web site as they are organized in the file system of your web server. This includes some folders that are created automatically by FrontPage, the private and images folder.
- **The Reports button** provides a summary of all the files associated with the web. There are many different reports that a user can choose, including: All Files, Recently Added Files, Recently Changed Files, Older Files, Unlinked Files, Slow Pages and more.
- **The Navigation view** resembles an organizational chart. This view is used to connect Web pages using shared borders or to existing web pages. Navigation view allows the
user to expand and collapse the view of the pages and create a printable copy of the web chart.

?? **The Hyperlinks button** displays the hyper-textual structure of your web site. The panel on the left is a top down view of the site in terms of the hyperlinks between documents: the top-level documents on the site are shown as the parents in an outline or tree display. The documents that they link to are displayed as children. The right hand panel displays the currently selected page with all of the documents that it links to, as well as all of those that link to it as indicated by the directional arrows.

?? **The Tasks button** displays a list of automatically and manually generated tasks for the maintenance of your web site. Automatically generated tasks can include such things as correcting spelling errors and fixing broken hyperlinks. In a collaborative web design environment, tasks can be installed to individual authors.

The **toolbar** at the top of the screen is similar to the toolbar in other Microsoft software products.

?? Along the top of the screen is the Toolbar, which has icons that are short cuts to frequently used tasks. Below the toolbar is a title that corresponds to the view that you have selected in the Views bar.

**Step 3. Add new pages to your FrontPage web**

Starting with a home page, we're going to create a simple site consisting of four pages that are linked together. We will use the Navigation view to accomplish this task. Create new page from within the Navigation view by selecting the small white page icon in the left hand corner of the screen. Notice that FrontPage saves this page as `index.html`. Your index page is your **home page**.

?? Click on the Home Page icon and create another New Page. This adds a new page labeled “New Page 2” below the home page in the Navigation panel. Repeat the same steps to create “New Page 3” and “New Page 4.”
Let’s add some meaningful titles to the new pages that we’ve just added to our web site. Click once on New Page 2 to make it blue. Use the Right Click button on the Mouse and Choose, Rename. You should see a blinking cursor in the box. Type a new name for the Box, and then hit enter. Do not change the name of the homepage. In order to follow this documentation easily, please leave the homepage as is and label your three child pages, Interests, Photo Album and Favorites.

At this point, your navigation view should look like the screen shot below.
Step 4. Formatting Pages
Formatting options in FrontPage include options to set shared borders, to define paragraph, page, and font settings, and select a page theme.

Defining Shared Borders
Shared borders are similar to headers and footers; they are used to provide a web with a consistent look and feel. The most common use of shared borders is to incorporate navigation buttons into your site so visitors can maneuver easily from page to page. Shared borders may be applied to the entire web or selected pages. We will apply shared borders to our entire web site.

?? With the home page selected, select Format, Shared Borders from the navigation view.
?? Apply the shared borders to All Pages. Check the Top and Navigation Buttons boxes.
Now let’s open our home page and edit the contents of the shared borders. Any changes we make to the border will appear on all pages in our web.

From the navigation view, double click on the home page.
Let's give our page a welcoming line. Delete index.html and write, “Mary's Web Page.” You can format the text as you would in Microsoft Word.

Right click on the italicized text and select Navigation Bar Properties. Select the radio button for Child Level under Home to set up links to all other pages in the web. Choose OK.

When we return to our index page, we now have links to the pages in our web.
Add text to the home page

?? You can add text to your home page by beginning to type just as you would in a word processor. I’ll just type a greeting: “Welcome to my web site!” When I press ENTER, a new paragraph is created

?? To begin a new paragraph press Enter

?? To single space your lines, hit CTRL-Enter

?? The tool bar at the top of the screen should look familiar if you have worked with Microsoft Word. The formatting toolbar allows you to edit Styles, Fonts, Font Size, Bold, Italics, Underline, Font Color, Left Justify, Center Justify, Right Justify, Bullet, Number. Just highlight the text, and choose the feature that you want.

?? It’s always a good idea to save your work before going on. All you need to do to save your work is do a file, save.
Adding a bulleted and Numbered Lists

?? As in Word, FrontPage allows you to create bulleted and numbered list.
?? Return to the Navigation view and double click on the Interests Page
?? Let's create a short list of activities and hobbies. First open the Bullets and Numbering option underneath Format. Type in your first hobby. When you hit enter, a bullet will precede the next line. By pressing ENTER twice we end the current list. Note that you can use the numbered list button to create numbered lists.
?? Notice the New Yorker hyperlink. We’ll cover hyperlinks in a following section
Section 5: Making Your Web Page Look Good!!

Background Color

?? Open the Photo Album page we created earlier by selecting File/Open. Select photo.htm and click Open.

?? Save your work
You can change the background color of your page.
Select Format, Background
Using the pull-down menu to the right of Automatic, set a standard color as the background for your page or select another color by exploring the color options underneath More Colors. Be careful when creating a custom colors. Colors that you create yourself using the Custom feature may not be viewable by all browsers.

Choose the color that you like and then hit OK. Your entire screen will now adopt the color you have just chosen.

**Importing Images**

You can add graphics to your web page. Let’s add a gif file to our site.

Again I’ll add some text at the top of the page: “Here is a picture of my best friend.”

From the **Insert** menu, choose **Image** and the Image dialog box will be displayed. Now, you have two options. You can either choose an image that you added to your images folder or you navigate to a drive on your computer and get some other image. Click on the Yellow folder with the Magnifying Glass in the bottom right hand corner. This option is called “select a file on your computer”
Then you are free to search through your files. Once you find the picture that you want to add to your site, select ok. You can use any “.jpg” or “.gif” files. These are just names of different kinds of image formats.

Your picture will now appear on your page. To edit the image, click on the image, using the little handles in the corner, expand or contract the image. Using the right mouse click you can edit other Image Properties.
Now would be a good time to save our work. Notice that when I click the **Save** button, the **Save Embedded Files** dialog appears. This asks me if I want to keep copies of the image files that I’ve just added to the Photo Album page with the rest of the files in our current web. Usually, you do want to do this. So I’ll click **OK**.

![Save Embedded Files dialog](image)

**ClipArt**

Clip art is a useful tool to know about. The Clip Art Gallery is a tool for previewing and inserting clip art, pictures, sounds, video clips, and animations that are pre-packaged with the FrontPage software.

- Do an **insert, clipart** to bring up the gallery. Search through the different categories to find the picture you want to add to your web page.
- Select the picture (If you get a message that says the file is stored on a disc, you will not be able to use that picture.) Insert the picture by selecting the top icon in the rectangular box that appears next to the selected piece of clip art.
The picture should now appear on your screen. You can resize it by selecting the picture and positioning your cursor over the small squares on the picture. If you drag the arrows that appear over these squares, you can size the picture to your liking.
Section 6: Creating hyperlinks
There are many ways to create hyperlinks in FrontPage, a few of which are listed below. Each of these options is accessible via the Create Hyperlink Dialog box shown below.

- Link to another page in your web site
- Simply type in URL on the page (URL = universal resource locator = web site address)
- Search the web and create a verified hyperlink (we’ll explain verified hyperlinks later)
- Link to a document in your web
- Create a hyperlink to an email address

Creating a Hyperlink by typing in the URL
- Open the "Favorites" page for editing.
- Type some text: “I like to listen to NPR”
- Click and drag over the text just typed to highlight the initials NPR
- On the Insert menu select Hyperlink.
- The Create Hyperlink dialog appears. In the URL field type the URL: http://www.npr.org. Click OK.
Notice that “NPR” is now underlined. The hyperlink status is confirmed when you hold the cursor over the link, and the address appears in the bottom left hand corner.

You can also create an automatic hyperlink by typing a URL anywhere on the screen, for example, www.npr.org or www.hotbot.com, and press Enter.

The URL becomes an active link. Click and drag to select it.
Now type the name of the site: Hotbot. The text changes but the active link remains.

Creating a verified hyperlink

Press the down arrow to go to the next line.
Type the name of the web site: Microsoft FrontPage and press enter.
Select the text you just typed.
In the Insert menu choose Hyperlink.
In the Create Hyperlink dialog box click the World Wide Web button.
This launches your web browser. By surfing to the page that you want to use and then switching back to FrontPage Editor (choose it from the boxes at the bottom or your screen or by switching between active software programs with ALT+TAB). FrontPage Editor was watching you surf, and the address of the selected page will appear in the URL field.

Creating a hyperlink to an email address

You can type an email address like mary_spidle@harvard.edu and hit ENTER
The text will automatically appear as a hyperlink. Or you can write some text like “E-mail me” and then highlight text, choose Insert/Hyperlink, and then choose the little
Section 7: Working with Documents and PDF files
You can create links to documents and PDF in FrontPage.

First, let’s add a Word document to our site.

First you need to Import the Document into your FrontPage web.

From the Favorites page, choose File, Import
Select Add File. Find the document you want to add to your web page, select it, and hit the Open button. In the diagram below, we are adding a pdf file and a Word document to our web page.

The name of the file should appear now in the Import File screen in FrontPage. Say OK.

The name of the file should appear now in the Import File screen in FrontPage. Say OK.
Now return to the page where you want to create the hyperlink.

Type some text such as, “Casey at the Bat.” Highlight the Text and choose Insert\Hyperlink. From the list of files, select your file. Choose OK.
Notice the text is now linked. When users click on the link on the internet, the computer will open the document in Microsoft Word.

Now let's add the pdf file to our website.

Again, on the Favorites page give a name to the link for the pdf. In our case, let's name it "The Taxman."

Select the text and do an Insert/Hyperlink. (This should look familiar!!)

Find the your file in you web folder.

Select the file and then say OK.
Visitors to your site will need to have Adobe Acrobat Reader installed on their computers to open the pdf file.

Make sure to save your changes.

Section 8. Previewing your home page in a web browser

There are two ways to preview your FrontPage web in a web browser:

- In the File menu choose Preview in Browser.
- Alternatively, you can preview your page by using the “Preview” tab at the bottom of the web page.

For those of you who really want to see the HTML, there is an HTML tab at the bottom left hand corner of the screen. FrontPage Editor has been creating the HTML, but you can go and edit it or view it by hitting the HTML view (it looks like a file folder tab). This is sometimes helpful to check if you have a little bug in your page.
Section 6. Publishing your web site

?? Save all the files that you have worked on.
?? Since you are working on the Unix server, your web page is live the moment that you save your work. Take a few moments now to look at your web page on the Internet using Netscape or Internet Explorer. You may have to hit reload or refresh on your screen to see the changes you have made. Remember that not all components of a web page will work with both browsers. If your page does not appear to your liking after you have published it, you may have to make some changes to the content of your site.

Section 7. Reopening your Web Page

?? When you need to edit your page, return to FrontPage
?? Select File/Open web.
?? You should see your web, and any other webs that you have worked on recently in the Open Web Screen.
?? Select the web you want to open and hit Open.
**Glossary**

Dictionary of computer and Internet terminology - [http://www.netlingo.com/](http://www.netlingo.com/)

**Browser** - Software that lets you view web sites (Netscape Navigator or Internet Explorer)

**FrontPage** - Microsoft’s Brand name for web site software. A program that allows the user to create and maintain webs and web pages. A web is a collection of HTML, graphic, sound, and other files that comprise a web site.

**HTML** - Hypertext Markup Language. Also known as Code. This is sort of like Word Perfect reveal Codes

**Index Page** - The opening page of your web site.

**Interface** - The system by which the software interacts with the software user

**URL** - Universal Resource Locator, fancy for web site address

**Web Page** - One single web page

**Web Site** - A collection of HTML, graphic, sound, and other.

**WYSIWIG** - What You See Is What You Get. It refers to the fact that when you create a web page using an editor, the editor automatically writes the HTML code for you.

**Additional Training**

For additional FrontPage training, you may want to check out the following web sites:

Productivity Point, [http://www.propoint.com/infront/home.htm](http://www.propoint.com/infront/home.htm)
An easy way to give your web page an attractive look is to use a **theme**. Themes give your site a unified feel by coordinating graphic elements, background images, and navigation bars. Some of the elements that are applied to a page by a theme include text colors, bullet styles, navigation bars, page banners, and page background images.

To apply a theme to your site:

1. Select the “themes” icon in the left-hand section of the screen.
2. Scroll through the list of themes. You can preview a theme by selecting the title. The theme will appear in the preview box to the right.
3. Find a theme that you like, then “apply” the theme to your web page. The theme used in this documentation is “Leaves.”

**Warning:** Not all of the components of the themes translate onto the web. Before you spend a lot of time on your page, make sure to preview your page in both Netscape and Internet Explorer. See Section 5, page 16.